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Guide

What are opening balances

First things first

Before working on your opening balances, make sure you have completed the Customise your
Company settings tasks. If you have not yet defined these settings , select Help > Customise your
company and follow the instructions provided.

If your company has been trading, it is likely that you will have opening balances that represent
your financial position. These balances need to be entered into your software.

Without accurate opening balances, the financial statements produced by your software can't give
a true picture of your financial position.

There are two methods for entering opening balances:

n Method 1 uses the Opening Balances window.

Most people prefer this method as it brings all the tasks needed to enter opening balances in
one place, so you can:

n See at a glance how far on you are with entering balances.

n Mark tasks as complete.

n Create customer and supplier records as you complete the process.

Full access rights to Opening Balances is needed to use the Opening Balances
window. Anyone with full access also has access to backup, restore and journals.

Note: The Opening Balances window does not support those with foreign currency
opening balances or when the software is set to operate as a Charity.

n Method 2 uses many areas of the software to enter opening balances.

This method is used when the software is set to operate as a Charity or when foreign currency
opening balances are involved. Accountants and those experienced in using Sage accounting
software may prefer this method.

Tip: If you prefer to view details about opening balances in booklet form, we have included a guide
supplied as a PDF. From the menu bar, choose Help > PDF Guides >Opening Balances.
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Getting started

First, you need to prepare a list of your opening balances. If you have an Accountant ask them to
prepare an opening trial balance for you. Otherwise, prepare a list yourself. See, Gathering your
opening balances on page 6.
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Gathering your opening balances

Prepare an opening trial balance

This is about listing all your nominal accounts and the value (balance) on each account.

1. Print the nominal list to identify the nominal accounts you have decided to use for your
business.

Choose Company>Nominal Ledger, then click Print List.

2. Add two columns to the print out, one for debit and one for credit.

3. Refer to your previous bookkeeping method to find the value (balance) of each listed nominal
account.

4. Write the value (balance) of each nominal account as either a debit or a credit.

Tip: In accounting terms an asset to the business is recorded as a debit and a liability is
recorded as a credit.

5. Total the values in the debit column and then total the values for the credit column. The debit
value should equal the credit value.

Prepare bank, customer and supplier opening balances

This is about breaking down certain values in the trial balance, which youmay find beneficial. The
following should help you to decide if you need to do this and how it is done.

Standard VAT and the UK Flat rate - invoiced based scheme: As VAT becomes liable at
the point of sale, the assumption is the VAT on your transactions has already been dealt with in
your previous accounting system. During opening balance entry your software applies the T9 non-
vatable tax code to transactions. Therefore, tax is not calculated, there is no impact on the VAT
Control account or further VAT Returns. If a transaction has not been VAT reconciled you should
enter it as a new transaction in your software.

Bank

Do you want to reconcile uncleared items, such as cheques? Then:

1. Match your bank statement to your bank records.

2. List each unlearned item.

The bank balance as shown on your bank statement is added to
your software as one amount. The uncleared items are added
separately as individual values. More about this later.

Tip:Money credited to your bank account is an asset to the business.
Accountancy rules show this as a debit on the bank account. This may
seem odd, but it is how the bank account views the money. The bank
account owes the business the amount that has been deposited, in
other words it is in debt to the business to that amount. On the other
hand, if the bank is overdrawn, it is a liability to the business and this will
be shown as a credit balance.
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Customers

Such values are needed if you intend to keep customer records to
monitor what they have purchased and what they owe you. If you
operate as a retail outlet using till and cash sales, you are unlikely to
track customers.

These values are the amounts each customer owes your business, and
can be found in documents such as outstanding invoices.

Each item can be recorded separately to a customer's record so it can
be aged, which is useful when chasing the customer for payment.

To break down your customer opening balances:

1. Check your sales records for outstanding transactions (invoices,
credit notes, payments on account).

2. List customers with outstanding transactions, together with the
value of the transactions, dealing with the VAT element as follows:

VAT Scheme Gross Net

Standard VAT (UK and Irish) ü x

UK Flat Rate Invoiced based ü x

VAT Cash Accounting (UK and Ireland) x ü

UK Flat Rate - Cash based x ü

Gross = The full amount for a transaction, including VAT.

Net = The transaction's value before tax, the tax rate and VAT
amount.

Tip: The total owed to you by all your customers is your opening
Debtors figure. If this figure does not match your Debtor figure
investigate further to try and identify the problem. If you can't resolve
the difference it does not stop you from entering your opening figures,
but expect warnings to be displayed by your software from time to time
to indicate there are discrepancies.
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Suppliers

These values are needed if you intend to keep supplier records to
monitor what you have purchased and what you owe them.

Such values are the amounts you owe each supplier and can be found in
documents such as outstanding invoices.

Each item can be recorded separately to a supplier's record so it can be
aged, which is useful when deciding when to make payment.

To break down your supplier opening balances:

1. Check your purchase records for outstanding transactions -
invoices, credit notes, payments on account.

2. List suppliers with outstanding transactions, together with the value
of the transactions, dealing with the VAT element as follows:

VAT Scheme Gross VAT Net VAT

Standard VAT (UK and Irish) ü x

UK Flat Rate Invoiced based ü x

VAT Cash Accounting (UK) x ü

VAT Cash Accounting (Irish) ü x

UK Flat Rate - Cash based x ü

Gross = The full amount for a transaction, including VAT.

Net = The transaction's value before tax, the tax rate and VAT
amount.

Tip: The total owed to all your suppliers is your opening Creditors figure.
If the figure does not match your Creditors figure, investigate further to
try and identify the problem. If you cannot resolve the difference it does
not stop you from entering your opening figures, but expect warnings to
be displayed by your software from time to time to indicate there are
discrepancies.
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Entering opening balances
Once you knowwhat your opening figures are, and in some cases your opening balances for bank,
suppliers and customers, they are ready to be entered into SAge 50 Accounts.

Method 1 - Using the Opening Balances window

1. From the Tools menu, choose Opening Balances.

The Sage Accounts Opening Balances window opens.

2. Complete each listed task and as you do so, your software adds a tick to the task's check box
to indicate it has been done.

Tip: For detailed information when working with the data entrywindows, press F1 on your
keyboard to open Help.

Enter a default
date for your
opening
balances

This date is suggested for use in the various data entrywindows
used to complete opening balances.

It may speed up the entry of the opening balances if you intend to
use the same date for each balance, but can be changed to suit
individual opening balances.

1. Select Enter a default date for your opening balances.

The Set a Default Date window opens.

2. Enter a date for your opening balances.

Tip: If you have just completed your financial year, this would
be the most sensible date to use. For example, if your financial
year starts in January, then enter the 31st of December. If you
are part way through a financial year, choose a date at the end
of the most recent closed month. For example, if you are
starting from June, and your financial year starts January, enter
the 31st May.

3. Click Save.
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Enter opening
balances for
your customers

Such values are needed if you intend to keep customer records to
monitor what they have purchased and what they owe you. If you
operate as a retail outlet using till and cash sales, you are unlikely to
track customers.

These values are the amounts each customer owes your business,
and can be found in documents such as outstanding invoices.

Each item can be recorded separately to a customer's record so it
can be aged, which is useful when chasing the customer for
payment.

Tip: You can create customer records during this task.

1. Select Enter customers opening balance.

The Customer Opening Balances window opens.

2. Enter your customer opening balances into the table.

If a customer's opening balance comprises more than one
transaction and you want to age each outstanding debt, enter
each transaction on a separate row using the transaction's
original date, thereby overwriting the default opening balance
date.

If you are using either the Standard VAT or UK Flat Rate Invoice
based VAT scheme, and are not interested in ageing the
outstanding debt, enter a customer's opening balance as a
lump sum.

3. When the Balance value at the top right of the windowmatches
your opening balance for all customers, click Save.
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Enter opening
balances for
your suppliers

These values are needed if you intend to keep supplier records to
monitor what you have purchased and what you owe them.

Such values are the amounts you owe each supplier and can be
found in documents such as outstanding invoices.

Each item can be recorded separately to a supplier's record so it
can be aged, which is useful when deciding when to make payment.

Tip: You can create supplier records during this task.

1. Select Enter suppliers opening balance.

The Supplier Opening Balances window opens.

2. Enter your supplier opening balances into the table.

If a supplier's opening balance comprises more than one
transaction and you want to age each outstanding debt, enter
each transaction on a separate row, using the transaction's
original date, thereby overwriting the default opening balance
date.

If you are using either the Standard VAT or UK Flat Rate Invoice
based VAT scheme, and are not interested in ageing the
outstanding debt, enter a supplier's opening balance as a lump
sum.

3. When the Balance value at the top right of the windowmatches
your opening balance for all suppliers, click Save.
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Check the
opening
balances

Generate reports and use them to confirm the opening balances are
entered correctly.

1. Select Check the customer and supplier opening balances.

The Criteria for Batch Report window opens.

Tip:Criteria control what information is displayed in a report,
such as a date range.

2. Enter the criteria for the reports, then click OK.

The data and period range are suggested for you based on your
default opening balance date and your financial year start date,
and should be OK to use.

Use the Customer Ref drop-down list to select a range of
customers with opening balances. Repeat this for suppliers.

The reports are displayed in previewmode.

3. Use the Aged Debtors Analysis (detailed) report to check your
customer opening balances.

Ensure your opening balances details match the transaction
detail in the report.

4. Use the Creditors Analysis (detailed) to check your supplier
opening balances.

Ensure your opening balances details match the transaction
detail in the report.

5. Use the Period Trial Balance report to ensure your accounts
balance. Check the report's:

n Debtors value matches the total opening balances
expected for customers.

n Creditors value matches the total opening balances
expected for suppliers.

n Debit and Credit totals are equal.

If discrepancies are found correct them before proceeding.
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Reverse the
opening
balances in
preparation for
entering the
trail balance

It may seem odd to undo your customer and suppler opening
balances, but those tasks are about getting outstanding items
added to trading records so you knowwhat you owe and who owes
you. Due to double-entry booking rules, values are also added to
Debtors Control, Creditors Control and Suspense nominal accounts.
This affect needs to be cleared before the nominal account balances
can be added (these are in your trial balance) as the trial balance is
likely to include a balance for both your debtors and creditors control
accounts. Otherwise the values are duplicated.

When you reverse the opening balances a journal is created for you.
This journal brings together the values that need to be cleared from
the accounts.

1. Select Reverse the opening balance.

You are prompted to take a backup of your data. We
recommend you do this before proceeding. If you choose
to do this, the backup window appears to complete the
task, then you are returned to the Opening Balances
Reversals window.

The Opening Balances Reversals window displays nominal
accounts and values needed to reverse the opening balances
you have entered and reflects those in the Period Trial Balance.

2. Check the debits and credits for the Debtors Control and
Creditors Control accounts match those in the Period Trial
Balance and Balance box is zero.

3. Click Reverse to generate the journal and clear your Debtors,
Creditors and Suspense accounts.
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Enter the trial
balance from
your
accountant

A trial balance is a list of nominal accounts and the value on each
account. It represents what assets the business owns, and what
liabilities it owes.

These values are spread across the nominal accounts you have
decided to use to track your business worth, such as bank, stock,
capital, loans. It is likely to include creditors, which is the amount
you owe to your suppliers; and debtors, the amount your customers
owe you, as detailed earlier.

When entering a bank balance, enter it as a lump sum to cover
cleared and uncleared items. If you want to be able to reconcile
uncleared items you can enter those transactions as individual
items in the next task. Don't worry about inflating a bank's balance
as this is dealt with for you as part of the task.

Tip: If you don't have an accountant, you can prepare your own trial
balance. See Gathering your opening balances on page 6.

1. Select Enter the trial balance from your accountant.

The Trial Balance Entrywindow appears.

2. Enter your trial balance into the table, until the Balance box is
zero and both the Debit and Credit totals display equal
amounts.

3. Click Save.
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Enter the
uncleared
transactions
for your bank
accounts(s)

If you want to reconcile transactions that have not yet cleared your
bank account, you need to enter these separately so that they are
added as individual items to the bank account record.

As with customer and supplier opening balances, the double-entry
booking keeping also affects the Suspense account. To ensure this
is cleared, when you complete this task a reversing journal is
generated between bank accounts and Suspense account. This
journal uses the default opening balance date.

Tip: If you have more than one bank account, you can enter an
opening balance for each account during this task.

1. Select Enter the uncleared transactions for your bank account.

The BankOpening Balances window opens.

2. Enter each uncleared bank transaction into the table.

3. Click Save.

Check opening
balances again
the trial
balance from
your
accountant

Generate the Period Trial Balance report and confirm the recorded
opening balances are correct.

1. Select Check opening balances against the trial balance from
your accountant.

The Criteria for Period Trial Balance window appears.

2. Click OK to generate the report.

3. Check the values in the report match those you expect for your
opening balances.

4. Check the Suspense Account has a zero balance.

If not, see Opening Balances Frequently Asked Questions on
page 25.
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Check your
data

This is an optional task, but it is a good idea to check your data to
ensure everything is working as it should.

1. Select Check your data.

The File maintenance window opens.

If there are no problems, the File Maintenance window appears,
informing you of this. To continue, click OK.

If problems are found they are displayed in the File Maintenance
Problems Report window.

Backup your
data

Take a copy of your data incase your computer fails, or if you
encounter data corruption. If you have a recent copy of your
data it can then be restored.

1. Select Backup your data.

The Backup window opens.

2. Enter the backup details and then click OK.

16



Sage Accounts Opening Balances

Method 2 - Entering opening balances

Use this method if you are a Charity or have foreign currency opening balances.

Enter your customer opening balances

1. Select the Customers module then, if appropriate, use the view selector to switch to the
Customers view.

2. Select the customers you have opening balances for, then click Customer Record.

The Customer Record window appears, showing the details of the first customer you selected.

3. Choose the OB button, which is attached to the Balance box.

The Opening Balance Setup window appears.

4. Enter the opening balance details, which are dependant on your VAT scheme.

Standard VAT scheme

Ref

Enter the reference for this opening balance. This reference appears
on the audit trail and will help you to identify this transaction. If you
are entering each outstanding invoice/credit note separately, you
can enter the invoice or credit note number. Alternatively you can
enter O/BAL as the reference.

Date

Enter the original date for the transaction. This ages the
invoice/credit note correctly by that date, so you can have an
accurate picture of the overdue debts on all your customer
accounts. Alternatively, you can enter the last day of the previous
accounting period. For example, the last day of the previous
financial year.

Note: The date used must always be in the previous accounting
period. For example, if you are entering your opening balances for
financial year commencing January 2011, the opening balance must
be dated December 2010 or earlier.
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Type

From the drop-down list, select the type of opening balance you
want to enter - Invoice or Credit.

If you owe your customermoney, choose Credit from the drop-down
list. This would create a negative balance when you enter their
opening balance. If they owe youmoney, you would choose Invoice.

Gross

Enter the full amount of the outstanding transaction.

Tip: If you don't want to age this customers debt, you could enter
the total amount as a lump sum rather than entering transactions
separately.

VAT Cash Accounting scheme

Ref

Enter the reference for this opening balance. This reference appears
on the audit trail and will help you to identify this transaction. If you
are entering each outstanding invoice/credit note separately, you
can enter the invoice or credit note number. Alternatively you can
enter O/BAL as the reference.

Date

Enter the original date for the transaction. This ages the
invoice/credit note correctly by that date, so you can have an
accurate picture of the overdue debts on all your customer
accounts. Alternatively, you can enter the last day of the previous
accounting period. For example, the last day of the previous financial
year.

Note: the date used must always be in the previous accounting
period. For example, if you are entering your opening balances for
financial year commencing January 2012, the opening balance must
be dated December 2011 or earlier.
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Type

From the drop-down list, select the type of opening balance you
want to enter - Invoice or Credit. If you owe your customermoney,
choose Credit from the drop-down list. This would create a negative
balance when you enter their opening balance. If they owe you
money, you would choose Invoice.

Net Enter the net amount of the original transaction.

T/C

The default tax code for this customer is suggested for use.

If it does not match that used for the original transaction, select
another from the drop-down list.

VAT
Your software calculates the amount of VAT due, but you can
change it if necessary.

Tip: Press ENTER after each entry to move to the next entry box.

5. To accept these details, click Save.

6. To return to the Customers window, click Close.

Enter your supplier opening balances

1. Select the Suppliers module then, if appropriate, use the view selector to switch to the
Suppliers view.

2. Select the suppliers you have opening balances for, then click Supplier Record.

The Supplier Record window appears, showing the details of the first supplier you selected.

3. In the Supplier Balance box, click the OB button.

The Opening Balance Setup window appears.

4. Enter the opening balance details, which are dependant on your VAT scheme.

Standard VAT scheme
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Ref

Enter the reference for this opening balance. This reference appears
on the audit trail and will help you to identify this transaction. If you
are entering outstanding invoices/credit notes separately, you can
enter the invoice or credit note number. Alternatively you can enter
O/BAL as the reference.

Date

Enter the original date for the transaction. This ages the
invoice/credit note correctly by that date, so you can have an
accurate picture of the overdue debts on all your customer
accounts. Alternatively, you can enter the last day of the previous
accounting period. For example, the last day of the previous
financial year.

Note: The date used must always be in the previous accounting
period. For example, if you are entering your opening balances for
financial year commencing January 2011, the opening balance must
be dated December 2010 or earlier.

Type

From the drop-down list, select the type of opening balance you
want to enter - Invoice or Credit. If you owe your suppliermoney,
choose Invoice from the drop-down list.If they owe youmoney you
would choose Credit. This would create a negative balance when
you enter their opening balance.

Gross

Enter the full amount of the outstanding transaction.

Tip: If you don't want to age the transactions for this supplier, you
could enter the total amount as a lump sum rather than entering
transactions separately.

VAT Cash Accounting scheme

Ref

Enter the reference for this opening balance. This reference appears
on the audit trail and will help you to identify this transaction. If you
are entering outstanding invoices/credit notes separately, you can
enter the invoice or credit note number. Alternatively you can enter
O/BAL as the reference.
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Date

Enter the original date for the transaction. This ages the
invoice/credit note correctly by that date, so you can have an
accurate picture of the overdue debts on all your customer
accounts. Alternatively, you can enter the last day of the previous
accounting period. For example, the last day of the previous financial
year.

Note: The date used must always be in the previous accounting
period. For example, if you are entering your opening balances for
financial year commencing January 2012, the opening balance must
be dated December 2011 or earlier.

Type

From the drop-down list, select the type of opening balance you
want to enter - Invoice or Credit.

If you owe your suppliermoney, choose Invoice from the drop-down
list.If they owe youmoney you would choose Credit. This would
create a negative balance when you enter their opening balance.

Net Enter the net amount of the original transaction.

T/C

The default tax code for this supplier is suggested for use.

If it does not match that used for the original transaction, select
another from the drop-down list.

VAT
Your software calculates the amount of VAT due, but you can
change it if necessary.

Tip: Press ENTER after each entry to move to the next entry box.

5. To accept these details, click Save.

6. To return to the Suppliers, click Close.

Check the customer and supplier opening balances

1. To check your customer opening balances, from the Customers module, click Reports.

2. From the Customer Reports Browser, select the Aged Debtors reports folder.

3. From the list of reports, print the Aged Debtors Analysis Detail report.

4. Use this report to check that you have entered the correct customer opening balances and if
necessary, amend any entries before proceeding.

5. To check your supplier opening balances, from the Suppliers module, click Reports.

6. From the Supplier Reports Browser, select the Aged Creditors reports folder.

7. From the list of reports, print the Aged Creditors Analysis Detail report.
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8. Use this report to check that you have entered the correct supplier opening balances and if
necessary, amend any entries before proceeding.

Reverse the customer and supplier opening balances

1. Print the trial balance report.

Open the Companymodule, from the Links pane select Financials then click Trial Balance.

Select the required output, for example printer then click Run.

From the Period drop-down list, choose the required Trial Balance period, for example, Brought
Forward

Complete the Print window then to print the report, click OK.

2. Clear the opening balances.

Open the Companymodule then from the Tasks pane select Journal Entry.

Enter a reference and date for the journal, then enter the relevant information to reverse the
trial balance figures.

To save the journal, click Save.

The journal posts and the Nominal Ledger Journals window clears.

Enter your nominal opening balances

1. Open the Companymodule, from the Links pane select Nominal Ledger then select the
required nominal code.

2. From the Nominal Ledger toolbar, click Nominal Record, click O/B then enter the opening
balance information into the Opening Balance Setup window.

Ref
Enter a text reference. This text appears on the audit trail and
will help you identify the transaction. The text O/Bal is entered
for you as the default, but you can change it if you want.

Date Enter the last day of your previous accounting period.

Debit

Enter the debit value, if appropriate. Asset nominal ledger
accounts, for example, bank accounts, purchases and overhead
accounts, for example, electricity charges, are normally debit
values.

Credit
Enter the credit value, if appropriate. Liability nominal ledger
accounts, for example, loans and income accounts, for
example, sales of wine, are normally credit values.

Tip: Debit balances usually include, fixed assets, bank accounts that are not overdrawn,
purchases and overhead accounts such as electricity charges.
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3. To save the opening balance, click Save.

The opening balance is saved and the Nominal Record appears.

Repeat this process until you have entered all of your Nominal Ledger opening balances

Enter the bank opening balances through the Bank record

Note: If you have already entered your bank opening balances through the Nominal Record, you
must not enter them again, but move onto check your nominal and bank opening balances.

1. Open the Bankmodule, select the bank account for which you want to enter an opening
balance then click Bank Record.

The Bank Record window appears.

2. From the Bank Record, click O/B then enter the opening balance information into the Opening
Balance Setup window, for example:

Note: The O/B button is part of the Current Balance box.

Ref
Enter a reference. This appears on the audit trail and helps you
to identify the transaction. O/BAL is entered by default, but can
be amended.

Date
Enter the date. This should be the last day of your previous
accounting period.

Receipt
If you have money in this account this is a debit balance, and
should be entered here.

Payment
If you are overdrawn in your bank account, this is a credit
balance, and should be entered here.

3. To save the opening balance, click Save.

The opening balance is saved and the Bank Record appears.

4. To close the Bank Record and return to the Bank Accounts window, click Close.

Repeat this process until you have entered all of your bank opening balances.

Check the nominal and bank opening balances

1. Open the Companymodule, from the Links pane select Financials then click Trial Balance.

The Print Output window appears.

2. Select the required output, for example, Printer then click Run.

The Criteria window appears.

3. From the Period drop-down list, choose the required Trial Balance period, for example, Brought
Forward.

If you selected the Printer output, the Print window appears.
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4. Complete the Print window as required then to print the Trial Balance report, click OK.

5. Use the figures from this trial balance to check that you have posted all your nominal and bank
opening balances. You should also ensure that the Suspense nominal code balance is zero. If it
is not, print the Nominal Activity report and check for the following:

n All nominal opening balances from your trial balance have been entered.

n None of the opening balances have been entered twice.

n Balances have not been entered as debits when they should be credits, and vice versa.

Check and back up your data

1. Run the CheckData option to check the validity of your data files.

Choose File >Maintenance >CheckData.

2. Take at least one backup of your data files.

Choose File > Backup.

This ensures that in the future you can restore back to this point. You maywant to do this to
check the values or details of your opening balances.
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Opening Balances Frequently Asked Questions

Q. My Period Trial Balance includes a balance for the Suspense Account. What should I do?

A. Print the Nominal Activity report (Company>Reports >Nominal Activity Reports) then check
the following:

n All nominal balances from your trial balance have been entered.

n None of the opening balances have been entered twice.

n Balances have not been entered as debits when they should be credits, and vice versa.

n Opening balances have been entered using an incorrect date.

Q. How do I deal with product opening balances?

A. Products (stock) are treated differently to other accounts in your software as they don't directly
affect the Nominal Ledger. Any adjustments to the Nominal Ledger, as a result of products, are
made using a journal. Entering your product balances is about adding the quantity and value of
products to individual product records. It is more about stock taking than it is about
accounting.

In terms of the opening balance, this is typically dealt with in your opening trial balance when
you would expect to add values to your stock nominal account.

Q. When is the best time to enter opening balances?

A. If you have just completed your financial year, this would be the most sensible date to use for
your opening balances. If you are part way through a financial year, choose a date at the end of
the most recent month which has been closed.

Q. After completing my opening balances, how should I deal with new accounts as they are added to
the software?

A. This depends on the account you are adding:

n Customer and supplier accounts - simply add the sales transactions such as invoices and
orders to the account as usual.

n Bank and nominal accounts - use a journal to update the necessary accounts.

n Products accounts - use the OB button on the product record.

Q. What are the opening balance buttons found on many accounts used for?

A. There are a number ways to enter opening balances.

Those with experience of the software and opening balances may prefer to use the OB buttons.
They are also used to enter opening balances when the software is up for a Charity or when the
opening balances include foreign currency values. See Method 2 - Entering opening balances
on page 17.

25


	What are opening balances
	First things first
	Getting started

	Gathering your opening balances
	Prepare an opening trial balance
	Prepare bank, customer and supplier opening balances

	Entering opening balances
	Method 1 - Using the Opening Balances window
	Method 2 - Entering opening balances
	Enter your customer opening balances
	Enter your supplier opening balances
	Check the customer and supplier opening balances
	Reverse the customer and supplier opening balances
	Enter your nominal opening balances
	Enter the bank opening balances through the Bank record
	Check the nominal and bank opening balances
	Check and back up your data


	Opening Balances Frequently Asked Questions

